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Ahhhh! Things are looking up a bit, at least in my
little corner of the world!

After a labor dispute that resulted in a 99 day
lockout, baseball is back. Yep, the American pastime
is back. I’m a baseball fan. More specifically, I’m a
Kansas City Royals fan. I’m a fan of my hometown
team, through thick and thin, good times and bad
times. They’ve certainly had their bad times since
winning the World Series in 2015, but I remain a fan,
nonetheless.

I’ve been a Royals fan since their inception in 1969.
Even when I lived in the Chicagoland area, I would
only go to a baseball game there if the Royals were
in town – when I could afford it and fit it into my
schedule. When I couldn’t make it to games, listen to
the games, or watch the games on TV, I would
spend the next day pouring over the box scores of
the game to see how my favorite players and the
team were doing. Many times, it wasn’t necessarily
what anyone would call good, but I was still a fan all
the same.

One of my earliest and fondest memories was
attending a Kansas City A’s game at the old (and
now gone) Municipal Stadium. I attended that game
in 1965 or 1966 with my parents and maternal
grandparents. Of course, the Kansas City A’s pulled
up their tent stakes and moved to Oakland after the
1967 season, paving the way for the 1969
expansion of Major League Baseball, which gave
birth to the Kansas City Royals.

As a kid, I would often sit on the porch at my
grandparents house, and listen to the baseball
games on the radio with my grandfather. So, I was
exposed to it all at quite an early age. I wasn’t able
to play baseball well, but I was still a fan. On most
nights today, you will find the Kansas City Royals

games playing on my TV. If I’m driving somewhere,
you’ll find me listening to the games on the radio.
But just like with anything, there are things that I find
annoying about the play-by-play announcers. And
this happens on both the TV and radio. For me, it’s
like fingernails on a chalkboard.

Let’s say there’s the start of a pitching duel. The
score is 0-0. The announcers, as they break for
commercials in between every half inning, will say
something along the lines of “and after three innings,
there’s no score.”

ARGH! SCREEEEEECH! (fingernails on a
chalkboard)

Yes, there is a score! It’s 0-0!

To be honest, I’m willing to meet halfway. I’ll accept
“after three innings, we remain scoreless.”
Technically and linguistically, even that is inaccurate,
but it sure sounds a whole lot better than “there is no
score.” And, to give fair credit, the announcers do
actually say that … sometimes. But the “there is no
score” utterance remains the most common thing
they say.

It’s not just our local announcers who are guilty of
this, either. I’ve heard the announcers on games
with a national audience say it, too.

From The Chief Editor's Desk . . .
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We all have little items like this that just grate on our
last nerve. This one resurfaced for me, as it usually
does, when the new baseball season got underway.
I’m sure if you think about it, you also have similar
“things” that annoy you, especially when it concerns
something you’re really interested in.

********************

This month, we mourn the loss of our long time
friend, forum member, Linux user and enthusiast,
and all around GREAT guy, Alain Baudrez, a.k.a.
Wamukota. To honor him (and to allow those who
didn’t have the privilege of getting to know him to
experience his enthusiasm), we’re reprinting some of
the articles Alain wrote for the magazine. R.I.P., our
dear friend!

********************

This month’s cover is by Meemaw. It commemorates
Kite Day, on May 12. Click on the previous link for
instructions on how to make your own homemade
kite.

********************

Until next month, I bid you peace, happiness,
serenity, prosperity, and continued good health.

Screenshot ShowcaseScreenshot Showcase

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!

http: //twitter.com/iluvpclinuxos

Posted by tuxlink, on March 31 , 2022, running KDE.

From The Chief Editor's Desk ...

http://twitter.com/iluvpclinuxos
http://www.commandlinefu.com
http://www.pclosusers.com/services-signup.php
https://www.instructables.com/id/A-Garbage-Bag-Kite/
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by Paul Arnote (parnote)

On April 20, 2022, we lost one of our longtime
PCLinuxOS forum users. Alain Baudrez, who often
went by the nickname Wamukota, chose euthanasia
to end his suffering from ALS, or Amyotrophic Lateral
Sclerosis.

Alain was one of the founders of the PCLinuxOS.nl
site and forum back in 2005. There, he helped

moderate the Dutch forum, and was active in Linux
user groups around his area, including Brutux -
LinuxCafé. He also wrote some tutorials to help
Dutch users adapt the English-language PCLinuxOS
to Dutch for those whose native language was
Dutch.

Word about Alain’s deteriorating condition was
forwarded to the PCLinuxOS forum family by his
friend and colleague mutse, also known as Maurice.

You can view mutse’s forum thread here. In early
February of this year, mutse reported that Alain’s
condition was worsening after undergoing back
surgery. At that time, mutse reported that Alain was
ceasing all Linux related activities, due to his
condition.

In early March 2022, Alain got the news that he had
ALS. While he could still talk, Alain set about making
his last will and testament, and filling out euthanasia
paperwork.

ALS, more informally and more commonly referred
to as “Lou Gehrig Disease” after the famous New
York Yankees baseball player, is a dastardly and
insidious disease. It can progress rather slowly, or it
can move with lightning speed. Unfortunately, Alain
appeared to have had the latter form.

Mutse continued to update the forum about Alain’s
worsening condition. On April 24, 2022, mutse
reported that Alain had passed away by euthanasia
on April 20, 2022. Alain leaves behind his loving
wife, Brigitte. He was 65 years old.

Here at The PCLinuxOS Magazine, me and
Assistant Editor Meemaw decided that the best way
to honor Alain would be to re-run his contributions to
the magazine over the years. We not only hope you
enjoy them as much as the first time they appeared,
but that you also remember Alain and his
contributions to his PCLinuxOS family via his forum
posts. What better way is there to “get to know” or
remember Alain except through his own words.

Rest in peace, our dear friend. Your memory lives on
in each of us whose lives you touched.

Alain Baudrez/Wamukota: In Remembrance

https://www.als.org/understanding-als/what-is-als
https://www.pclinuxos.com/forum/index.php/topic,157117.msg1352893.html#msg1352893
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Reprint from the August 2009 issue

Most of you will know the Netherlands as the country
where Dutch is the native tongue, but Dutch is also
spoken in the northern part of Belgium (Flanders). A
total of 20 million people speak Dutch, so our
community is an international community of 550
members with Dutch and Belgian admins, mods and
users.

How It All Started

In November 2006, Mike (NewMikey) and Jos
(DutchWolfie) set up a forum to support Dutch
speaking PCLinuxOS users, and NewMikey rolled
out a localized PCLinuxOS remaster. It may seem
strange to some Linux users, but quite a lot of
people have problems with English-based software
and the localized remaster was a big success.
Success means more users, more users means
more support and since the release of PCLinuxOS
2007, the Dutch community has grown significantly.

What Do We Do Nowadays

The core business is of course maintaining an active
forum and proving the much needed info for new
users. Alain J. Baudrez (Wamukota) created a Dutch
'Get started with PCLinuxOS' tutorial, along with
some basic Linux tips on the Dutch website.

DutchWolfie added a Google Map so that new users
can look-up a nearby PCLinuxOS user if help is
needed. Wim (JohnW_57) is known as mod on the
regular IRC channels, and both he and Jan
(Smurfslover) are also known for their outstanding
support on these channels and in testing for
development. Both are team members who joined
us very early on, since last year we added two new
members to the PCLinuxOS.NL team. Ed (DeBaas)
and Oliver (Oli4) have expanded the Mods, and are
regular visitors of the international PCLinuxOS
forum, acting as a go between for those users who
don't speak English. NewMikey created a special
remaster aimed at the photography fan
(http://www.dfpe.pclinuxos.nl/) [inactive link].

There is no need to create a localized Dutch version
of the 2009, thanks to pinoc's AddLocale tool. He
created a great piece of software, and it helps us a
lot. Thank you, pinoc.

As PCLinuxOS is broadening its horizons with
Gnome, XFCE, LXDE and other community
remasters, we recently opened new forums for them.

Our long term plans

We can state that our community has finally
mustered a crew of enthusiastic PCLinuxOS users,
so that we now have a solid base to expand our
activities. The first new item is the translation of the
PCLinuxOS Magazine to Dutch and to get a “video”
handbook out on our site as well.

It's easier than E=mc2

It's elemental

It's l ight years ahead

It's a wise choice

It's Radical ly Simple

It's .. .

PCLinuxOS Dutch Community :: PCLinuxOS.nl

http://www.pclinuxos.com
http://www.linuxforum.com
https://pclosmag.com/html/Issues/200908/page07.html
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by Alain Baudrez (Wamukota)
Reprint from August 2010

I've read many postings and rants about Linux not
being ready for the desktop, while my experience
tends to state the opposite. Linux is – and has been
for the last couple of years – ready for the desktop.

It all boils down to the type of audience you speak
to.

Windows has been developed with the industry in
mind. That implies that you have a group of well-
trained IT guys who do the Windows laundry while
you, at your desk, can work without bothering
whether the latest patches are applied, the AV is up
to date, Anti-malware filters are in place, …

But let's look at a typical home user.

What does 'Jane Doe' do (or would like to do)
with her computer?

• Browse the web

• Send & Receive eMail

• Instant Messaging

• Twitter

• Skype

• Rip audio to MP3

• Play and organize her music collection

• Transfer music between PC and MP3 player

• Upload pictures/movies from a digital camera

• Red eye removal and minor enchantments of
pictures

• Watch movies on DVD

• Edit her own video recordings

• Burn CD/DVD

• Write a few letters

• Keep budget in check with a simple spreadsheet

• Make small posters for festivities

• Create and maintain a website

• Play games

Alain Baudrez, a.k.a. Wamukota

Linux IS Ready For The Desktop

https://pclosmag.com/html/Issues/201008/page01.html
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• Install new software

• Interact with wireless networks and bluetooth
devices

Those actions seem familiar and they 'can' all be
done with the pre-installed Windows. Correction. Not
if you stick to your pre-installed Windows. For most
of those actions, you need to buy expensive
software, which for most of us is not tax deductible.

Looking at that list through Linux glasses, with the
exception of some games, all can be done using a
free modern state of the art Linux distribution.

So, Linux clearly has the edge on Windows here,
and Windows being pre-installed anyway, we always
have a fall-back for the few things that can not be
done through Linux. Should Windows not come pre-
installed, Linux would struggle, especially in the
games area. But the simple fact that Windows
comes pre-installed plays into the hands of a dual-
boot Windows/Linux solution.

What should the same Jane Doe not have to do?

• Tamper with the system

• Bother about the legal status of the OS

• Fight malware and other nastinesses of the
Internet

• Be responsible for maintaining system integrity
through updates and patches

• Buy new hardware every 3 years to be able to
accommodate the latest imposed upgrades

• Buy expensive software

When using Windows, this is just what Jane Doe has
to do to keep her box running. The problems and
performance loss inherent in the Windows system

are a far cry from the fun and joy of having a
computer she expected.

A modern Linux distribution is much simpler to
maintain. Its concepts prevent a user crippling the
system by disallowing her to venture in typical
system folders. There are no legal issues. The
distribution can be copied, passed on, etc., without
problems.

There are almost no risks that viruses or malware
will cripple the system.

Installing software is free and comes from a certified
single set of servers.

Linux runs much longer on the same hardware.

All in all, Linux has the edge on Windows here too.

The general consensus is that Linux is hard to
install. One cannot expect an average user to install
Linux to dual-boot with their current Windows
installation.

In fact, Linux is no harder to install than any other
Operating System. But since Windows comes pre-
installed, all the user must do is to activate the end
user license to get going. The only thing we – Linux
users - must do, is to install it on their computer in
dual-boot mode, and give them a few how-tos on
how to work with it. Isn't that something we all have
done in the past many times?

Linux is ready for the desktop if you never hear back
from those converted users again. It works and just
keeps on working, something that cannot be said
about the other pre-installed operating system.

Available in the following desktops:

KDE LXDE Xfce

MATE Trinity

Enlightenment

Linux IS Ready For The Desktop

http://www.pclinuxos.com
http://www.opensource.org/
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by Paul Arnote (parnote)
Reprint from May, 2010

Let me thank you for the opportunity to express myself
through the Behind the Scenes series. As a community is
more than just one person, this article also covers 'The
Making Of PCLinuxOS.nl' and has inputs from other
PCLinuxOS.nl members (as indicated by their [alias]). —
Alain J. Baudrez

Alain J. Baudrez

Can you start us off by introducing yourself, and
by telling us a bit about you (where you live, age,
full name, marital status, children, hobbies,
etc.)?

In cyberspace I am known as Wamukota — an
African male name meaning 'left-handed' in the
Abaluhya language (Kenya) — while in meatspace I
listen to the name of Alain J. Baudrez. I am a 53

years old retired sysadmin/programmer from the
Belgian Navy. I am married to Brigitte. Having no
children, our common hobbies are our pets (2 dogs
and 3 cats), while I have taken up photography
(again) as I have plenty of time now ;-).

I live in Brugge, a small semi-medieval town in the
North-Western part of Belgium. In the Northern part
of Belgium (Flanders) we speak Flemish, which is a
dialect of the Dutch language. In the Southern part
of Belgium French is the main language. The written
language is the same in both the Netherlands and in
Flanders, which comes in handy when setting up a
multinational community.

In 2001 I was diagnosed with ESRD (End Stage
Renal Disease) which resulted in both my kidneys
shutting down in March 2002. I had to go to the
hospital three times a week to have my blood filtered
using dialysis. Luckily I got a donor kidney on April
23, 2003. I can not express how grateful I am
towards the unknown donor who saved my life.

When did you first get started with computers,
and what were you running?

It all started somewhere in 1976 when I received a
portable calculator (Texas TI SR-56) from a cousin
who preferred the HP series as they were using the
RPN (Reverse Polish Notation) method of entering
data. The SR-56 was programmable (100 steps and
8 memory registers) and I made my first programs
on it. The next major step was the Tandy TRS-80
Model I where I learned how to program in a kind of
Basic language. From there the usual evolution
followed such as the first SS/SD floppy drives for the
model I, and consequently learning TRS-DOS. I did
work with the CP/M based Schneider 6128 and
enjoyed IBM OS/2 2.0.

As an autodidact, my 'wizardry' with computers did
not go by unnoticed on board the frigates I was
assigned to. I had a portable Tandy Model 100 with
me at that time, and my CO suggested that I apply
for an ICT job in our Navy. So, in 1986 I stopped
sailing and became one of the first
programmers/sysadmins of the Belgian Navy
running Microsoft products, and it has remained
Microsoft for the rest of my professional career.

My first encounter with Linux was S.u.S.E Linux 4.2
(around 1996-97), where a colleague used it to run a
kind of gateway between our intranet and our ISP to
collect and distribute POP3 mails.

I switched from Microsoft being my main OS at
home to Linux with Suse Linux 9.2.

When did you switch to running PCLinuxOS, and
what attracted you to PCLinuxOS?

I started using PCLinuxOS with version 0.93 and the
first TRs of the 2007 version. At that time, I was still
using openSUSE, but problems getting wireless up
and running (ndiswrapper through console) and
multimedia woes made me look for a snappier and
more complete distro. It didn't take long to find
PCLinuxOS which, even in its 2007 Beta state, was
just what I was looking for. It was simple, complete,
fast and it was the first distro where productivity was
the focus, not 'making the thing work.' Moreover,
there was already a nice and fresh Dutch community
emerging.

As an administrator of PCLinuxOS.nl, can you
please tell us about the Dutch community using
PCLinuxOS? (how many members, when it was
formed, who are the moderators and
administrators there, forum activity, etc.).

Editor’s Note: Please keep in mind that this article is 12
years old, so some of the topics discussed are no longer
relevant, and items are discussed that no longer exist.
As the saying goes, time marches on.

Behind The Scenes: Wamukota & PCLinuxOS.nl

http://www.brugge.be/internet/en/index.htm
https://www.pclosmag.com/html/Issues/201005/page11.html
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The Dutch PCLinuxOS community was founded by
Mike Bing (NewMikey) and Jos Wolfkamp
(DutchWolfie) who had met on the Dutch language
forum at pclinuxos.com. NewMikey was a
PCLinuxOS "convert" from then-Mandrake as far
back as PCLinuxOS Preview 81a. The website in its
actual form was brought online November 30, 2005,
but it took until Xmas of 2006 before we saw any
other members besides our little group and some
family and friends (NewMikey's son, Rayman has
been using PCLinuxOS since age 9 and became a
contributor to the forums as well).

[NewMikey] We would be amiss if we did not
recognize the help and support of Lars of
PCLinuxOS.de, the German site. One of the very
first emails said:

On Wednesday 30 november 2005 17:03, Mike Bing
wrote:

Lars,

Thanks for your speedy reply. Just a few questions: in
order to register pclinuxos.de did you get authorization
from Tex first? How do you finance it? Instead of
registering pclinuxos.nl would it be possible to join forces
on pclinuxos.org and make it truly multilingual? (A bit
like the Mandrake Club site. )

I would not want to host packages because of the risk of
losing compatibility with the main PCLOS, what is your
opinion? Could there be a "PCLOS Club"?

Jos, I know you are interested in the distro from our
exchanges on the PCLOS Dutch language forum (the.
com), would you be interested to join up to accomplish
something like that?

To both of you: thanks for thinking (meedenken).

Mike

We went straight to Tex for his permission/approval
as we felt very strongly about not using the name

Behind The Scenes: Wamukota & PCLinuxOS.nl
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PCLinuxOS unless Tex liked the idea. We received
our reply a few days late as Tex turned out to have
been very busy with P.A.S.S.

His elaborate reply, on December 4th, 2005, after
being asked whether he was OK with us setting up
pclinuxos.nl, was:

Subject: Re: Dutch website Tex?
From: Texstar

Yes, it's fine with me.

[Wamukota] There are currently four admins being
both founders NewMikey and DutchWolfie, Ed M.
Berntsen (DeBaas) and me. The moderators are Jan
T'Jaeckx (Smurfslover), Wim Willemsen (JohnW)
and Oliver van Praag (Oli4). As of today we count
just over 600 names on our member list.

Another unique fact is that PCLinuxOS.nl, is a pure
bi-national team effort. Admins, mods and members
come from the Netherlands, as well as from
Flanders in Belgium. It is actually a bonus, as both
cultures are slightly different; the vocabulary differs
slightly; the Dutch are more outgoing while the
Flemish are more conservative. We even type on
two different keyboards: the Dutch use the standard
QWERTY, while in Flanders we use the French
AZERTY keyboard. We even differ on religious and
political ideas, but that has never been an issue. It is
just the other way round. We learn much about our
neighbors.

The activity on the forum cannot be compared with
what you have on the US forum. First, the number of
Dutch speaking people (population 16,500,000 for
the Netherlands and 6,100,000 for Flanders) running
Linux is small. Secondly, many of those
speak/read/write English fluently, so we won't see
them very often.

How would you describe the average Dutch
PCLinuxOS user?

[DeBaas] I'd like to jump in, as Linux started for me
as PCLinuxOS. 93. It was the first one that changed
my view on Linux from 'impossible to get working' to
'easy and one time install.'

From here, 2007, I found PCLinuxOS as the OS that
demonstrated the power of Linux at PC clubs, even
family parties and other reunions, with help of only a
CD or USB stick.

So in my opinion, the average Dutch PCLinuxOS
user is caught by surprise, overwhelmed by the ease
of PCLinuxOS and never looks back.

What particular challenges face Dutch
PCLinuxOS users that English-speaking users
don't have to face?

[DeBaas] The use of Pinoc's addlocale and the
getopenoffice scripts, including the install of different
dictionaries, are the only challenging options to be
included for the Dutch users. (Side-note to the Dutch
magazine readers: Your help with program
translations is still appreciated).

How has Pinoc's addlocale impacted the
adoption of PCLinuxOS among Dutch users?

As NewMikey had already made a localized (Dutch)
remaster of PCLinuxOS. 93 and PCLinuxOS 2007,
most PCLinuxOS users never did experience the
'manual' way of changing the default English

language to Dutch. We also provided an extensive
how-to on our forum — just in case.

Today, Pinoc's tool is a great way to let non-English
users change the localization of PCLinuxOS to any
given language. A largely unknown fact is that study
of foreign languages is very popular over here.
Pinoc's tool now provides users with an easy way to
create an extra user for whatever foreign language
they study. On my box, I have 3 separate users, one
for Dutch, one English and one French. As I intend
to study Russian from September onwards, I will
create an extra user with the Russian localization.
Pinoc's tool is just super for it.

Two versions of PCLinuxOS DPE (Digital
Photography Edition) have come out of the
efforts of the Dutch community. First, can you
give us a little history on the DPE version, and
second, what special enhancements are made to
the base installation to make the DPE version?

First of all, the two DPE's weren't the only thing to
come out of this community, we had a fully Dutch
localized mainstream PCLinuxOS ISO on our
servers for some years now (see previous
paragraph), which was renewed upon every fresh
release. We have discontinued the habit because
Pinoc's excellent work now makes it possible for
everybody to localize his/her install in minutes.

The first DPE was actually a snapshot of
NewMikey's running installation. Being a die-hard
photography addict, this install had a lot of stuff
floating around that came out of this photography
hobby, such as color profiles, contrast curves, RAW
development scripts in Bash and Kommander and a
great collection of scripts and plugins for GIMP.
There even was a Konqueror service menu
dedicated to RAW development. As this install was
only used for image editing, gradually the collection
of graphical programs expanded.

Behind The Scenes: Wamukota & PCLinuxOS.nl

http://www.fsf.org
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At one point in time, the standard updates of certain
packages through the repos did not keep up with the
rapid technical progress in Linux-photography land
and some software packages were either built from
source, or old SPEC files were used with new(er)
source tarballs to create customized RPMs. This
was done particularly with DCRAW and UFRAW, to
keep up with new camera models that were not
recognized in the older versions, but also with
LuminanceHDR (formerly known as QTPFSGUI)
and the Hugin panorama editor, due to their rapid
rate of development.

There was also a stage where we received approval
from Gábor Horváth, the author of RawTherapee
(back then not yet open-sourced) to include his
excellent package, and we went through some close
cooperation with David Tschumperlee — author of
the GreyCstoration (now GMIC) noise reduction and
image manipulation package — on making the
software more accepting of large images and small
memory spaces by a process called tiling.

Eventually, the install had become so photography-
specific and the collection of tools such a great
showcase of what was available for photo-editing in
Linux. It became obvious that it would be a great
idea to provide an ISO, website and forum to
promote the software and drive more users directly
to the authors' websites, as well as promoting and
popularizing PCLinuxOS as a distro. We always
stressed that DPE was not a distro, but merely a
remaster showcasing the versatility of PCLinuxOS.
For that particular reason, the donation links on the
Dutch website always pointed one way only … to
Tex's donation page.

As the versions of PCLinuxOS progressed, we
trusted that DPE would upgrade as any PCLinuxOS
install would, through the repos, until it became
obvious about a year ago that certain tools (like
RawTherapee) would need a more invasive upgrade
of core libraries like libstdc++, as well as a newer C
compiler version. When Linuxera and the rest of the
team started on a major overhaul of the whole

toolchain, that opportunity seemed to come closer
and work began on DPE2.

At the same time, NewMikey upgraded his camera
yet again (an illness also known as CBA: Camera
Buying Addiction — somewhat related to LBA: Lens
Buying Addiction — both incurable) and this time the
14.6 megapixel files resulting from this new and
wonderful camera began slowing down the 1GB Dell
laptop with external USB drive that DPE was running
on. A memory upgrade was out of the question on
the aging Dell laptop and therefore, sacrifices had to
be made.

This resulted in a switch to LXDE as a lightweight
low-memory, yet functional and esthetically pleasing
desktop environment as a basis for DPE2. Ever
since, a release candidate has been available for
download on http://hamsta.net/pclinuxos/, web-
space donated by a very friendly Linux-fan.

As for now, the waiting for PCLinuxOS2010 is over
and the final version of DPE2 will be available just
as soon as we can update.

What are the plans for a new DPE version based
on the upcoming releases, and upon which
version will the DPE version be built?

[NewMikey] The new version of DPE, DPE2 Final
will be built upon PCLinuxOS 2010 LXDE, which
seems all set to become a rock-solid platform.

Is there an anticipated release date for a new
DPE version?

[NewMikey] Well, I am tempted to say that it will be
ready when it's ready. I am waiting for Gabor to
release RawTherapee 3, which is a major upgrade,
but I'm willing to consider doing a DPE 2 as soon as
2010 final is out end then DPE 2.5 when Gabor
releases. Again, between a busy job with
international travel and a family with 2 teenage kids,

things do tend to get sidetracked now and then, so
YMMV.

What closing words of advice or wisdom would
you like to leave us with?

I would like to end with a tribute to and quote of
Bruno Knaapen (Amsterdam 28 November 1950 —
20 February 2010), one of the great open-source
and Linux advocates, a friend and Linux mentor to
many in the Linux Community.

"We try to avoid the word 'newbie', it does no justice to
the efforts we, also the beginners, put in to learn a new
operating system. I think the wish to learn Linux shows a
brave attitude and deserves a better qualification."

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Behind The Scenes: Wamukota & PCLinuxOS.nl

http://www.pclinuxos.com/?page_id=10
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Prologue by Paul Arnote [parnote]
Original Story by Alain Baudrez [Wamukota]
Reprint from February 2011

Prologue

On April 17, 2010, Alain Baudrez (a.k.a. Wamukota)
sent me a short story he had written, and asked me
if I would be interested in running it in The
PCLinuxOS Magazine. Set in the not too distant
future, it's a story depicting the collapse of the World
Wide Web.

Liked it? I loved it! I read it through three times upon
receiving the story, and each and every time, my
mind envisioned this story being told via a comic
strip. I definitely wanted to do this story justice, so I
started "shopping around" for someone with some
graphic skills who might be able to tackle such a
project. This was no small task.

I looked everywhere. I
checked with the usual
PCLinuxOS artists, but
all said that this was
something that they felt
was outside of their
graphics abilities.
However, one such
contact did lead to
another lead, which I
pursued. Timeth, an
Australian PCLinuxOS
user and artist who
teaches in Japan, had
some students who were

quite skilled at anime-type drawings, and he thought
that they would be able to do a good job.

So, I sent Alain's
manuscript to Timeth,
and he shared it with
them. They were
interested. So off they
headed, working in their
spare time to create a
multi-panel comic book
style presentation for
Alain's story. After
several months, their
outstanding work
appears here.

"One of my other hobbies is writing short stories. I've
done that since I was a teenager and now, at the
age of 54, I still love to write. I normally write stories
in Dutch, but once in a while, I like to try it in another
language. When I write some SciFi or Fantasy stuff,
it just makes sense to do it in English," said Alain
about his story.

"I really can't recall what gave me the idea, but this
story is simply one of the many plots I came up with,
where I play with the infamous Dec 21, 2012 date.
According to some, that date means the end of the
world, and in my story it is simply the end of the
WWW as we know it.

"I also hint at the freemasons at the end of the story.
You know they exist, but you don't know who is a
member. Between them, they have special secret
signs, which I refer to with the i-letter."

I would like to share the names of the students in
Japan with the rest of you, but privacy laws in Japan
prevent me from publishing their names here. So,
we've given their nicknames. They are two female
junior high school students, Moto-san and Hina-san.
So to Moto-san and Hina-san, if you are reading

this, I'd like to personally congratulate you on the
outstanding job you did with this project. You can
certainly be very proud of what you have helped
create here. Plus, I would like to thank you for your
hard work on this project.

This has truly ended up being an international
endeavor. Alain Baudrez, a PCLinuxOS user from
the Netherlands, wrote the story. He sent it here to
me, in the United States, to publish it. I sent it to an
Australian, teaching in Japan, to find a way to
illustrate it. And his students, from Japan, came
through with the illustrations.

I hope you enjoy the story, along with the comic-
book presentation, exclusively here in The
PCLinuxOS Magazine.

Donate NOW

DOWNLOAD

Mate Desktop

WWW Collapse

http://www.gofundme.com/pclinuxos-2016
https://pclosmag.com/html/Issues/201102/page12.html
https://pclosmag.com/html/Issues/201102/page13.html
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Screenshot ShowcaseScreenshot Showcase

Posted by The CrankyZombie, on March 31 , 2022, running KDE.
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Low Carbohydrate 3g

INGREDIENTS:

3 tablespoons butter
8 bone-in skin-on chicken thighs (2 1/2 to 3 lb total)
1 teaspoon lemon pepper
1/2 teaspoon salt
2 teaspoons finely chopped garlic
1 cup chicken broth (from 32-oz carton)
2 teaspoons grated lemon peel and 2 tablespoons
lemon juice (from 1 large lemon)
2 tablespoons cold water
2 tablespoons cornstarch

DIRECTIONS:

Spray 3 1/2- to 4-quart slow cooker with cooking
spray.

In a 12-inch nonstick skillet, heat 1 tablespoon of the
butter over medium-high heat. Season chicken with
1/2 teaspoon of the lemon pepper and the salt.
Place half of the chicken thighs skin-side down in a
skillet; cook for 4 to 5 minutes or until the skin is
golden brown and chicken releases easily from the

surface. Turn chicken over; cook for 2 minutes.
Repeat for remaining chicken.

Layer chicken thighs, skin-side up, inside slow
cooker; sprinkle with garlic. In a 2-cup measuring
cup, mix chicken broth, lemon peel, lemon juice and
remaining 1/2 teaspoon lemon pepper; pour over
chicken thighs. Cover and cook on Low heat setting
3 to 3 1/2 hours or until chicken is tender (at least
165 degrees F).

Remove chicken to a
serving platter; cover
and keep warm. In a
small bowl, mix water
and cornstarch; beat
with whisk into cooking
juices in slow cooker.
Cover and cook on
High heat setting 20 to
30 minutes or until
slightly thickened and
bubbly around edges.
Stir in remaining 2
tablespoons butter.

TIPS:

If desired, garnish with fresh slices of lemon or
chopped Italian (flat-leaf) parsley.

Add a green vegetable and rice or noodles for a
complete meal.

Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!

You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.

Join us on our Google Group mailing list.

PCLinuxOS Recipe Corner

Slow-Cooker Lemon Pepper Chicken

http://groups.google.com/group/pclinuxos-magazine
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by Paul Arnote (parnote)

Three months into my discovery of/journey with podcasts (yeah, yeah … I’m late
to the podcast party), I have amassed a fair collection of podcasts from a variety
of sources.

When I first started, I wanted to put each serial podcast (like “The Agent”) on a
MP3 CD to play on the MP3 CD player in my pickup truck. That led to my first
article in March 2022 about resampling the MP3 files at a lower bitrate so they
could all fit on a single 700MiB CD-R. Since then, I discovered the USB port on
my dash that is read by my truck’s audio system. So, I bought a few inexpensive
32GiB USB flash drives from Newegg.com. Now, with 32GiB of space to play
with, I’m not as concerned about the need to shrink the files down to fit onto a
standard CD-R.

But regardless of the medium – CD-R or USB flash drive – one problem persisted
that had me perplexed. The files were all jumbled on my truck’s audio system, as
well as on the audio system in my wife’s car. Granted, all of the files remained in
their folders, but within those folders, the files were all jumbled up, and not in the
order I had planned. Not only were the files jumbled, but the playback order was
jumbled, too. I soon discovered that the problem was also present on my
SanDisk Sansa Clip+ personal audio player, which I covered way back in October
2009. Yes, I still have it, and it still works perfectly (although it might be nice to
have a version that connects to my Bluetooth earbuds).

Sure, I could just stream the podcasts over my cell phone. But then what
happens when I’m traveling in one of the vehicles, and I’m in a fringe reception
area? Yep. You guessed it. No more streaming. This happens for us more
frequently than you might imagine. We also like to spend time outdoors, where
cell phone reception is spotty at best. So, it’s better to have a physical copy of the
podcast playing, either on CD, USB flash drive, or in the case of the Sansa Clip,
a microSD card. That way, the podcast playback isn’t dependent on whether or
not I have cell phone reception.

So, the first thing I tried was making sure there was a *.m3u playlist file in each
folder, hoping that would set things right. Nope. That had absolutely no effect
whatsoever.

Then, I tried renaming the files with numbers, usually starting with “000” and
incrementing all the way up to however many files were in the folder. I thought
that just maybe the audio system in the vehicles (and on the Sansa Clip) might
be using the filenames to determine the order of the files. Nope. That also had
absolutely no effect whatsoever, either.

So, the only other “thing” I could think of was that both my Sansa Clip and the
audio system in the vehicles were using the track number embedded into the
MP3 as ID3v2 data to determine the proper order of the tracks.

Upon checking the tag data in the MP3 files I had downloaded, each and every
one had a track number of “1.” So, none of my playback devices had any idea of
which order to play the files. You certainly don’t want to listen to chapter 1, and
then hear chapter 9 before you’ve heard chapters 2, 3, 4, 5, 6, 7, and 8. As a
result, the order seemed very random, although consistently so.

I checked the file order on my Sansa Clip. Yep. It was a jumbled mess, with files
not in the proper playback order. I went through and “edited” the tag info on one
of the smaller serial podcasts I had downloaded to my computer, and then copied
them over to the Sansa Clip. Specifically, I assigned each MP3 file a specific
track number within that folder. Voila! All of the files appeared on the Sansa Clip
in the proper playback order.Th
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https://www.iheart.com/podcast/1281-the-agent-88650856/
https://pclosmag.com/html/Issues/202203/page01.html
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https://www.pclosmag.com/html/Issues/200910/page19.html
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Since I use Thunar on Xfce, editing that info is fairly easy. Right click on the file,
select “Properties” from the context menu, then select the “Audio” tab in the
dialog box that appears. The very top left field is the “Track” number. Set the track
number for that particular episode, so the tracks play in the desired order. Then,
select the “Save” button, and then the “Close” button. I’m fairly certain that the
process is similar on other desktop environments, such as Mate, KDE Plasma,
LXQt, etc., and their associated file managers.

Yes, this method works fine. But the drawback is that you have to do each
individual file, one at a time. That would be fine if you have just a few files to do,
but if you have hundreds, this is going to take up a LOT of time. Just one of my
podcasts, a reading of the Federalist Papers from colonial times in America, has
85 separate files.

There has/had to be a faster, easier way than doing them all one individual file at
a time.

Thanks to some command line tools and executing them in a bash script, there is
a much easier way to assign a unique track number to each file in a folder. So
what did I do? I created yet another bash script to handle the task!

Just as when I created the bash scripts to handle the bitrate resampling and to
handle adding album art to your MP3 files, I created this script to be run either
from the command line, or from a Thunar custom action. It even has a graphical
progress bar, courtesy of Zenity.

So, below is the script I came up with. You can type it in (it’s definitely short
enough), or you can download it from the magazine website. The download file is
named mp3-track-renumber.sh.txt. As with the previous two bash scripts, save
the file to where you keep your bash scripts, remove the “.txt” file extension, and
make the file executable.

1. #! /bin/sh
2.
3. n=1
4.
5. for file in $@; do
6. if [ ! - e $file ] ; then
7. continue
8. fi
9.
10. echo "# Processing file: $file"
11. id3v2 - - track $n $file
12. echo $( ($n * 100 / $#) )
13. let "n = n+1"
14.
15. done | ( zenity - - progress - - title "Applying Track Number. . . "
- - width=400 - - height=100 - - percentage=0 - - auto- close - - auto- kill)
16.
17. exit 0

This is the shortest of the three MP3-related bash scripts that I’ve written over the
past three months. Including five blank lines, it’s only 17 lines long. Size-wise, it’s
only 388 bytes, so it’s not going to break the download quota bank.

Being a bash script, line 1 is the typical shebang that starts off every bash file.
Line 3 initializes “n” as an integer we’ll need later as we loop through multiple
files. It’s also the number used to assign a unique, incremented track number to
each file later on.

Lines 5 through 15 are the for-do loop that walks through multiple files supplied
as command line arguments. Lines 6 through 8 check to see if the supplied
filename actually exists. If it doesn’t, then it continues on with the next filename. If
the file exists, it then processes that file.

MP3 Files: Creating Order From A Jumbled Mess

https://pclosmag.com/Misc-Downloads/mp3-track-renumber.sh.txt
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Line 10 sets up the text to display in the Zenity progress dialog box. Line 11 calls
on the command line program id3v2 to set the track number using the integer
that we set up in the third line. I cannot remember if I had id3v2 already installed,
or if I had to install it from Synaptic. If you don’t have it installed on your
computer, definitely install it from Synaptic.

Line 12 sets up the percentage to be displayed in the Zenity progress dialog box,
while line 12 increments the integer by one for every file processed.

Line 15 closes out the for-do loop, and displays the Zenity progress dialog box.
Line 17 exits the script cleanly.

To be perfectly honest, the script often completes so quickly that I’m not able to
get an image of the Zenity progress dialog box when it is displayed. So instead, I

can show you the MP3 tag data (above) after the script has been run, which
shows the track number set in the ID3v2 data.

Using The Script

Like I mentioned earlier, I designed this script to be run either as a standalone
bash script from the command line, or as a Thunar custom action (which is how I
will mostly use it). As I’ve mentioned in my previous articles, I’m sure that this can
be added to the context menus of Dolphin or Caja, but because I haven’t run
KDE Plasma or Mate in quite a while, I’m no longer familiar enough with them to
be able to lead you through that process. However, I’m sure fans of those
desktops will have no difficulty finding a suitable guide to achieve similar
functionality. That isn’t within the scope of this article, though.

To ensure that the files are in the order that I want/need, I use Xfce’s multi-file
renaming utility. Using that, I preface every filename with numbers, usually
starting with “000” (I do it this way because I usually also download the “trailer” or
“prologue” for the serial podcasts I download, and number that file as chapter
zero), and using a dash as a separator between the numbers and the filename.

From the command line, you can specify individual files as command line
arguments, or you can use wildcards. If you specify individual files, each file is
separated by a space. Using wildcards, first cd to the directory where the MP3
files are stored, and then execute the command mp3-track-renumber.sh *.mp3

MP3 Files: Creating Order From A Jumbled Mess
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on the command line. In short order, your MP3 files will have the appropriate
track number recorded in the MP3 tag information.

I’ve set up the Thunar custom action as shown above (bottom of previous page).
I’ve named the custom action “MP3 Track Renumber.” The command is entered
as mp3-track-renumber.sh %N. I’ve also selected an unused icon from my
system to represent the custom action in Thunar’s context menu. Under the
“Appearance Conditions” tab, I’ve checked the “Audio Files” selection, and
entered *.mp3;*.MP3 as the “File Pattern” to match. Then, all I have to do is
select the MP3 files I want to renumber the track numbers of, and select the
custom action from Thunar’s context menu.

On a side note, your MP3 file names cannot contain spaces. I’ve covered this
previously with the other two MP3 scripts. Because spaces are used as delimiters
for command line parameters, spaces in file names will cause the script to not
work. At all. It’s best practice to eliminate spaces from file names anyway, to
avoid any such issues.

Summary

While I was glad to find a couple of ways to listen to podcasts while driving in the
vehicles, it was maddening to not have the files listed (and not played back) in
the proper order. It took me a bit to figure out exactly why this was occurring, too.
To be perfectly honest, I was a bit surprised that a *.m3u playlist didn’t resolve the
issue, as well. It’s not as if *.m3u playlists are anything new, so I felt confident
that they should/would be recognized by even the most basic MP3 player. Or so I
mistakenly thought. I was also surprised to discover that the filename had no
bearing on the playback order, as well.

Nope. The playback order is ruled by the track number assigned to the MP3 file
in the MP3 tag information. Who'da thunk it, right? Now that I’ve discovered the
proper way to ensure the proper playback order, I literally have created order out
of chaos, and my MP3 files now play in the proper order.[a] And along the way, I
created an easier, faster way to number (or renumber) the track/playback order of
my MP3 files.
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Get Your Free Copies Today!
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The Electronic Frontier Foundation (EFF)
by Naomi Gilens, Jennifer Lynch, and Veridiana Alimonti
Reprinted under Creative Commons Attribution License 3.0
Originally published April 5, 2022

Google is fighting back against a Brazilian court order to turn over data on all
users who searched for specific terms, including the name of a well-known
elected official and a busy downtown thoroughfare. (Brief in Portuguese and
English*) While we applaud Google for challenging this digital dragnet search in
Brazil, it must also stand up for the rights of its users against similar searches in
the U.S. and elsewhere.

Background: Keyword Search Warrants

Keyword search warrants like the one in Brazil are far broader than traditional
search warrants described in the Fourth Amendment to the U.S. Constitution. The
Fourth Amendment requires police to establish probable cause to search a
particular place or seize a particular person or thing before the court authorizes
the warrant. But keyword search warrants don’t start with a suspect person or
device. Instead, they require Google to comb through the search histories of all of
its users, including users who are not logged into a Google account when they
search.

Keyword warrants allow the police to learn anyone and everyone who may have
searched for particular terms on the off-chance one of those people could have
been involved with the crime. Like better-known geofence warrants, keyword
warrants allow police to conduct a fishing expedition and sweep up data on
innocent people, turning them into criminal suspects. Police are using both types
of expansive, suspicionless searches with increasing frequency.

Google Takes a Stand Against Keyword Search Warrants—in Brazil

The Brazilian case arises out of the assassination of Rio de Janeiro City
Councilor Marielle Franco. Franco was murdered, along with her driver, Anderson
Gomes, near Rio de Janeiro in 2018. It was a terrible crime that stirred up public
outcry.

As part of the investigation into the assassination, police ordered Google to trawl
through its users’ search histories, scanning for searches of certain
terms—including the name of a heavily trafficked street in Rio de Janeiro (“Rua
dos Inválidos”), Franco’s name, and the name of a nonprofit cultural space
intended to support Black women (Casa das Pretas), where Franco had
participated in an event earlier on the day she was killed. The order required
Google to turn over identifying data about all users who searched for these and
other related terms over the course of four days.

Google has challenged this order, eventually appealing it all the way to Brazil’s
Supreme Federal Court, arguing that this kind of indiscriminate search violates
the Brazilian constitution. (Google’s brief in Portuguese and English*) As Google
rightly explains, the warrant is wildly overbroad. The search terms would all have
been popular and common queries, and many people are likely to have used
them—including citizens and journalists interested in the activities of a city
councilor, or people interested in collaborating with or receiving support from the
nonprofit cultural center Casa das Pretas.

This particular keyword search warrant is particularly egregious, given the sheer
number of people likely caught in its dragnet, but even a more narrow warrant
should trigger human rights concerns. These types of warrants inevitably sweep
in users whom police have no reason to believe were involved in the crime, and
they give police unbridled discretion to determine which of these people to target
for further investigation. In the Fourth Amendment framework, the unbridled

Google Fights Dragnet Warrant For Users’ Search Histories
Overseas While Continuing To Give Data To Police In The U.S.
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discretion inherent in keyword search warrants, like
geofence warrants, makes them an unconstitutional
“general warrant.”

As Google emphasized in its brief, this case in Brazil
has far-reaching implications. This method of
investigating transforms a platform intended to
provide access to information into a tool for the
government to collect highly revealing private data
from innocent people. And Google receives
thousands of law enforcement orders to provide user
data in Brazil each year, affecting tens of thousands
of users. If Brazil’s Supreme Court signs off on
dragnet keyword searches, the number of impacted
users could skyrocket.

Google Fails to Challenge Keyword Search
Warrants in the U.S.

Keyword search orders are becoming increasingly
common in the U.S.—but Google seemingly hasn’t
fought nearly as hard to protect the privacy of its
U.S. users. We aren’t aware of any cases in which
Google has pushed back against keyword search
warrants in the U.S. In fact, we have no idea how
many keyword warrants Google receives or how it
responds to them at all, because Google has kept
that information entirely secret. That secrecy
surrounding keyword warrants contrasts with

Google’s recent reporting on geofence warrants;
Google has now shared the number of geofence
warrants it receives and the three-step process it
uses to respond to them.

It's remarkable that Google has taken a strong stand
in favor of user privacy in Brazil. But this problem
isn’t limited to one country, and Google could do
much more to protect its users. Google can and
should take proactive steps to address the highly
revealing capacity of its databases and adopt robust

data minimization measures on how user data is
processed and for long it is stored. And it should
take a stand in the courts to protect users in the U.S.
and other countries from dragnet keyword searches,
just like it’s doing in Brazil.

* The official copy of the brief that Google submitted to
the Brazilian court is only available in Portuguese. We
used an online tool to translate the brief into English so
there may be some inaccuracies in translation.
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Posted by tbschommer, on April 1 , 2022, running KDE.
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by Meemaw

When I search for tutorials, I always find something
from a different site than I have seen before.
Starlight86 does tutorials as well, and posts them on
his blog. He has done a tutorial for a bokeh effect in
GIMP and it looks fun. He has a brush that he
created to do the effect, so I went to Deviant Art and
downloaded it (you have to sign on to get it - here’s
the link). I also noticed that this was a Photoshop
project that he tested to see if it would work in GIMP.

OK. Open GIMP and start with a black rectangle the
size you want it. He used 1600 x 1200 px, but I’m
using 800 x 600 on this one. The next thing you want
to do is add a transparent layer, then fill it with a
radial gradient. Make your foreground purple and
your background black, then choose FG to BG.
Lower your Opacity to 50 and offset your gradient a
little.

Now we’re going to add a transparent layer. Change
your foreground color to white and use the brush.

Change it to the Bokeh brush and make a few
Bokeh circles on the layer in different sizes. Click on
Filters > Blur > Gaussian Blur. Your setting for this
layer should be 4.50 at least (using the newer tools).
We’re going to do this two more times and you want
some to look like they are farther away. This is one
where you use your own judgment.

(without the blur)

(with the blur)

You want to make two more layers of brush strokes,
each with less blur. I used 2.50 on the second, and
0.50 on the third.

Create a new white layer. Click on Render > Noise
> Difference Clouds (it is an older tool that used to
be in Render > Clouds). Use these settings:

GIMP Tutorial: A Bokeh Effect

https://www.deviantart.com/starsys/art/bokeh-brush-101230329
http://puteraaladin.blogspot.com/
http://puteraaladin.blogspot.com/2008/10/gimp-tutorial-awesome-bokeh-effect-in.html
https://www.deviantart.com/starsys/art/bokeh-brush-101230329


PCLinuxOS Magazine Page 30

After it is applied, go to the layers settings and
change the Mode to Overlay. It should now look like
this:

There is a bit of difference, but it looks sort of like it
did before and not how the clouds settings window
looks.

Now, create a new transparent layer (I named mine
Gradient2). Choose your Gradient tool and use a
linear, multi-color gradient. Make sure the Opacity is
100. After you apply the gradient, go and change the
Layer Mode to Overlay.

Go to your top Bokeh layer and change the layer
mode to Grain Merge. Then go to your 2nd Bokeh
layer and change the layer mode to Hard Light (I
didn’t see much of a difference on the 2nd one but
you might). You can export it now.

I hope yours turns out kind of like those at right.

It’ll change depending on the gradient you use. I did
three.
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by Paul Arnote (parnote)

Assault On Your Privacy: Monthly Update

I’m changing the graphic for the monthly update on
your privacy section, starting this month. With the
vast majority of the privacy threats emanating from
three principle countries hosting the threat actors
(People’s Republic of China, Russia, and North
Korea), let’s just “celebrate” their malfeasance to the
rest of the world by displaying their flags.

According to an article on BleepingComputer, Mars
Stealer malware has been spotted in the wild,
delivered via OpenOffice ads on Google. The
malware is a redesigned version of Oski malware
that ceased development in 2020. This malware
steals auto-fill information, browser extension data,
credit cards, IP address, country code, and
timezone. They were discovered when the Russian
threat actor inadvertently infected themselves with
the Mars Stealer malware during a debugging
session. That inadvertent infection exposed the
hacker’s GitLab accounts, along with stolen
credentials to pay for the Google Ads, according to
Morphisec, who discovered the new threat. They
also discovered that the information thieves are
focused on stealing cryptocurrency assets.

North Korea recently exploited a recently
uncovered remote code execution flaw in Google
Chrome (imagine that) to target U.S. based news
media, IT, cryptocurrency, and financial-technology
industries, according to an article on The Hacker
News. The new vulnerability, CVE-2022-0609, is
a[nother] “use after free” zero-day flaw discovered in
the Chrome browser. The exploit kit, according to the
Google TAG (Threat Analysis Group), is fashioned
as a multi-stage infection chain that involves
embedding the attack code within hidden internet
frames on both compromised websites as well as
rogue websites under their control, according to the
article.

In another article from The Hacker News, another
unidentified threat agent has been spotted
employing a “complex and powerful” malware
loader, with the ultimate goal of deploying
cryptomining malware on the infected computers.
Dubbed “Verblecon,” it uses polymorphic qualities to
evade detection by security software.

A group of hackers, some of whom may be
minors in the U.K. and the U.S., duped Apple and
Facebook (Meta) into providing private customer
data, according to an article on Bloomberg. That
data included customer addresses, phone numbers,
and IP addresses. Posing as law enforcement
officials, the hackers sent forged “emergency data
requests” to the companies, who then handed over
the information. It is suspected that the hackers
gained access to bona fide law enforcement
computer systems, and thus actual emergency data
requests. It’s speculated that they then used those
actual documents as a template to create their
forged documents.

Yet another Google Chrome browser vulnerability
was discovered that allows hackers to exploit the

V8 Javascript engine to allow the reading and
writing of data on an infected machine without
permissions, according to an article on Review
Geek. The vulnerability, CVE-2022-1096, affects all
Chromium/Chrome browsers, including Chrome,
Edge and Opera.

In the turn-about-is-fair-play department, a
Ukrainian computer researcher struck back at
one of the most formidable Russian ransomware
gangs, according to an article from CNN. The article
says the researcher “published the biggest leak ever
of files and data from Conti, a syndicate of Russian
and Eastern Europe cybercriminals wanted by the
FBI for conducting attacks on hundreds of US
organizations and causing millions of dollars in
losses.” The article continues, “The thousands of
internal documents and communications include
evidence that appears to suggest Conti operatives
have contacts within the Russian government,
including the FSB intelligence service. That supports
a longstanding US allegation that Moscow has
colluded with cybercriminals for strategic
advantage.”

Six “antivirus” apps were discovered in the
Google Play store recently by Check Point
Research that were caught stealing banking
information and credentials red-handed from users,
according to an article on Laptop Mag. The six
malicious apps CPR spotted included "Atom Clean-
Booster, Antivirus," "Antivirus, Super Cleaner,"
"Alpha Antivirus, Cleaner," "Powerful Cleaner,
Antivirus," and "Center Security - Antivirus." Google
has since removed these apps from the Google Play
store. If you have one of these apps installed on
your mobile device, it would be best to remove them
yesterday.
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Eco-Certified Computer Program

https://www.bleepingcomputer.com/news/security/mars-stealer-malware-pushed-via-openoffice-ads-on-google/
https://blog.morphisec.com/threat-research-mars-stealer
https://thehackernews.com/2022/03/north-korean-hackers-exploited-chrome.html
https://thehackernews.com/2022/02/new-chrome-0-day-bug-under-active.html
https://www.virustotal.com/gui/file/03a41d29e3c9763093aca13f1cc8bcc41b201a6839c381aaaccf891204335685
https://thehackernews.com/2022/03/new-malware-loader-verblecon-infects.html
https://www.bloomberg.com/news/articles/2022-03-30/apple-meta-gave-user-data-to-hackers-who-forged-legal-requests?sref=ylv224K8
https://www.reviewgeek.com/113436/hackers-exploit-a-critical-chrome-and-edge-vulnerability-update-now-to-fix-it/
https://security.virginia.edu/alerts/another-chrome-zero-day-flaw-cve-2022-1096
https://www.cnn.com/2022/03/30/politics/ukraine-hack-russian-ransomware-gang/index.html
https://www.laptopmag.com/news/six-antivirus-apps-are-spreading-malware


PCLinuxOS Magazine Page 32

If you use Google Chrome (or one of its
Chromium-based “siblings”), you may want to
make sure you are running updates
REGULARLY. Like, every other day or so. Over the
past month, I’ve read about two to three new Google
Chrome browser vulnerabilities each week. In fact,
there are way too many to list here and do so
accurately. So, the best defense is a strong offense.
Be proactive, not reactive. If you continue to use the
Google Chrome browser as your daily driver
browser, run updates frequently to keep your
data/information as safe as it deserves.

Mozilla’s Vision For The Evolution Of The Web

I admit it. I’m a diehard Firefox fan. I like how Mozilla
approached the browser, and the steps it takes to
keep its users safe from the assorted riff-raff out
there on the interwebs. I like Mozilla’s philosophy.
I’ve been a Firefox user since its earliest days, and
have remained a faithful user ever since. Nothing
else quite feels “like home” to me as I’m browsing
the web as it does when I’m using Firefox.

Well, if Mozilla had their way (and I hope they do),
the web would be a much safer place for all users.
Mozilla holds to their goals expressed in the Mozilla
Manifesto. They put out their mission statement for
all to see. They invite everyone to participate, to
have a seat at the table, if you will.

They have even gone so far as to publish their
vision for the continued evolution of the web. In a
nutshell, they want to build an internet that has
openness, agency, safety, privacy, security,

performance, and user control at the core of web
principles.

I wish them well and much success in their efforts.
Know that they have my full support, as they most
likely have broad support from all around the world
and from many different corners of our human
existence.

At the very least, it’s a good, refreshing read, and
well worth your time.

First Ever Eco-Certified Computer Program:
KDE's Popular PDF Reader Okular

Okular, KDE’s popular multi-platform PDF reader
and universal document viewer, has officially been
recognized for sustainable software design as
reflected in the recent award criteria for software
eco-certification. In February 2022 Okular was
awarded the Blue Angel ecolabel, the official
environmental label awarded by the German
government. Introduced in 1978, Blue Angel is the
world’s earliest established environmental label, and
Okular is the first software product to be certified
with its seal. What is more, Okular is the first  ever
eco-certified computer program within the 30
organizations of the Global Ecolabelling Network!
This network, of which Blue Angel is a member,
represents over 50 countries.

You can read more about the award here.

Increase Privacy With Brave Browser

Out of the gates, Brave browser is much better
about guarding your privacy than Google Chrome,
despite having similar DNA as the Google Chrome
browser. BUT, you can make Brave help protect your
privacy even more.

You can change what appears on your default home
screen in Brave, prevent it from calling home (ever),
control what information is shared with the websites
you visit, block social media tracking, and lots more.

For the full rundown on making the tweaks to the
Brave browser, head on over to the article on
Lifehacker, and follow the steps laid out there.
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DuckDuckGo Removes Pirate Sites, Youtube-dl
From Search Results

Reprinted from TorrentFreak under CC-SA-3.0 license.
April 15, 2022. Privacy-centered search engine
DuckDuckGo has completely removed the search
results for many popular pirate sites including The
Pirate Bay, 1337x, and Fmovies. Several YouTube
ripping services have disappeared, too and even the
homepage of the open-source software youtube-
mp3 is unfindable.

Launched in 2008, search engine DuckDuckGo is a
go-to service for Internet users who value their
privacy.

Unlike many competitors, the site doesn’t keep a
record of users’ IP addresses or other sensitive
information.

In recent years, the site also stood out by returning
cleaner results than competitors such as Google,
which actively alters its algorithms to downrank
pirate sites. At one point, Google even pointed users
to DuckDuckGo when they searched for Pirate Bay
proxies.

DuckDuckGo Fears Liability

The privacy-focused search engine is not immune to
potential copyright issues, however. This first
became apparent when it removed several search
shortcuts for ‘pirate’ sites. These “bangs”, as they
are called, were seen as a potential copyright
infringement liability.

“We operate globally, as do bangs, and products that
actively facilitate interaction with illegal content can
have us and our employees face significant legal
liability, and jeopardizing the entire service,”
DuckDuckBang’s Tagawa explained.

DuckDuckGo ended up removing roughly 2,000
bangs for popular sites including The Pirate Bay,
1337x, and RARBG. At the time, the search engine
stressed that these sites were still listed in search
results. However, that appears to have changed
now.

Pirate Domains are Deindexed?

When doing some research earlier today we noticed
that several popular pirate sites were no longer
showing up in DuckDuckGo’s results globally.
Initially, we thought that some popular pages had
been removed following DMCA takedown notices,
but there is clearly more going on than that.

Update April 17: DuckDuckGo informs us that no
domains were removed but they are having some
issues and we still have questions. More details are
at the bottom of the article.

For example, searching for “site:thepiratebay.org” is
supposed to return all results DuckDuckGo has
indexed for The Pirate Bay’s main domain name. In
this case, there are none.

The lack of results is not tied to a specific country
and manually fiddling with the region settings didn’t
change anything either. Apparently, DuckDuckgo has

simply removed all thepiratebay.org URLs from its
index.

This whole-site removal isn’t limited to The Pirate
Bay either. When we do similar searches for
1337x.to, Fmovies.to, Lookmovie.io, and
123moviesfree.net, no results appear. For RarBG.to
and Fitgirl-repacks we only get one result, instead of
the hundreds of thousands we see on other search
engines.

The absence of results doesn’t only apply to pirate
sites themselves. For example, there are no results
for the streaming portals Flixtor and Primewire. In
addition, the associated status pages, which merely
include links to the official domains, are not indexed
either.

Even several popular stream-rippers have been
completely wiped from the search results. That
includes 2conv.com, Flvto.bid, and several others.

Youtube-dl Gone?

The most surprising omission, by far, is that the
official site for the open-source software youtube-dl
is not indexed by DuckDuckGo. This site certainly
doesn’t host or link to any copyright-infringing
material.

The youtube-dl code repository was previously
removed from GitHub, following a takedown notice
sent by the RIAA. After looking more closely at the
matter, Github eventually restored it.

We don’t know why the official youtube-dl.org
website is not in DuckDuckGo’s search results, but
at least the official GitHub repository is still findable.

Why?

TorrentFreak reached out to DuckDuckGo to
discover why these domain names are not showing
up in its search results. At the time of publication, we
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have yet to hear back. It wouldn’t be a surprise if the
move is copyright-related, though.

A few months ago, Google also started to remove
several pirate site domains from its search results.
However, in Google’s case, these delistings are
regional and linked to ISP blocking orders.

It’s worth pointing out that many pirate sites are still
findable in DuckDuckGo. However, the search
engine could certainly provide some transparency to
help clear up what’s happening exactly.

Rightsholders will be happy to see that pirate sites
are removed from DuckDuckGo, but it’s not without
risks for users. While seasoned pirates can probably
still locate the sites in question, more shady knockoff
sites will now appear higher in its search results.

—

Update April 17: DuckDuckGo has responded to
our findings and says that no domains were
removed, according to their records.

Before publishing the article we searched for
YouTube-dl and The Pirate Bay without the “site:”
operator the official domains were not showing up at
our end. They do now.

DuckDuckGo’s statement below seems to contradict
our initial findings, however.

“After looking into this, our records indicate that
YouTube-dl and The Pirate Bay were not removed
from our search results when you searched for them
directly by name or URL — as you noted in your
piece. This is how the vast majority of people
navigate to a page.”

“As our CEO & Founder shared in this tweet, we are
having issues with our site: operator, and not just for
these sites, but now at least the official site should
be coming up for people when they use the site:
operator for them.”

Interestingly, both YouTube-dl and Thepiratebay.org
still don’t show up on Bing. We asked DuckDuckGo
whether this could be related to Bing data they use
and will update this article if we hear back (see
update 2 below).

Still Unfindable?

Also, there are other “pirate” sites that we didn’t
mention in the original article that are still unfindable
in DuckDuckGo.

For example, YTMP3.cc, which is one of the most
popular YouTube rippers with millions of monthly
visitors. According to the “site:” operator there are 0
results indexed. And searching for YTMP3.cc or
YTMP3 doesn’t bring up the site either. Google has
no trouble finding this domain (but Bing does).

Or what about the torrent site Prostylex.org?
According to the “site:” operator there are zero
results indexed and searching for Prostylex.org or
Prostylex doesn’t bring up the official site either.
Again, the domain is findable in Google.

We don’t doubt that DuckDuckGo hasn’t intentionally
removed any URLs but there still appear to be
strange issues with pirate-related searches.

Update 2: A DuckDuckGo spokesperson confirmed
to TorrentFreak that the issues are related to Bing
data.

Update April 18: The unfindable domains we
pointed out in the update are back now as well, after
we informed DuckDuckGo about the issue.

Then, on April 19, TorrentFreak wrote a follow-up
article.

Last week we noticed that several high-profile
"pirate" sites were unfindable in DuckDuckGo's
search results. It wasn't clear why these domains
had been 'removed' but after some back and forth,
Bing is now mentioned as the culprit. DuckDuckGo

is working hard to mitigate the problem, which is
more widespread than we initially reported.

It’s not a secret that Google and Bing are tweaking
their search results to accommodate copyright
holders.

However, it was a surprise to see that pirate and
related sites also started to disappear from
DuckDuckGo, as we reported last week.

An initial review revealed that the official domains for
sites such as The Pirate Bay, Fmovies, and
YouTube-DL were no longer showing up. This led us
to conclude that they had been removed for some
reason or another.

Not Removed?

DuckDuckGo didn’t immediately respond to our
findings but after two days DuckDuckGo founder
and CEO Gabriel Weinberg reacted on Twitter.

According to Weinberg, the search engine never
removed anything. Instead, the problems were
attributed to the “site:” search operator we used as
an example in our article. Apparently, that is broken.

“We are not ‘purging’ YouTube-dl or The Pirate Bay
and they both have actually been continuously
available in our results if you search for them by
name (which most people do). Our site: operator
(which hardly anyone uses) is having issues which
we are looking into,” Weinberg wrote.

These comments suggest that our coverage was
wrong. However, that’s not the full picture, far from it.

When we wrote our article, we didn’t only use the
“site:” operator. We also searched for keywords
directly, without the domain names showing up. This
means that the sites were unfindable for another
reason.

Short Topix: Okular First Ever Eco-Certified Computer Program

https://torrentfreak.com/mpa-googles-delisting-of-thousands-of-pirate-sites-works-220322/
https://torrentfreak.com/mpa-googles-delisting-of-thousands-of-pirate-sites-works-220322/
https://twitter.com/yegg/status/1515636218691739653
https://duckduckgo.com/?q=ytmp3.cc
https://duckduckgo.com/?q=ytmp3
https://duckduckgo.com/?q=site%3Aprostylex.org
https://duckduckgo.com/?q=site%3Aprostylex.org
https://duckduckgo.com/?q=prostylex
https://torrentfreak.com/duckduckgo-restores-pirate-sites-and-points-to-bing-220419/
https://torrentfreak.com/duckduckgo-restores-pirate-sites-and-points-to-bing-220419/
https://torrentfreak.com/search-engines-and-rightsholders-sign-landmark-anti-piracy-deal-170220/
https://torrentfreak.com/search-engines-and-rightsholders-sign-landmark-anti-piracy-deal-170220/
https://torrentfreak.com/duckduckgo-removes-pirate-sites-and-youtube-dl-from-its-search-results-220415/
https://twitter.com/yegg/status/1515636218691739653


PCLinuxOS Magazine Page 35

DuckDuckGo Restoral

Coinciding with the tweets from DuckDuckGo’s
CEO, several of the domains we listed in our article
started to reappear in the search engine. The Pirate
Bay homepage reappeared, and the same applies to
YouTube-DL and Fmovies, even when we use the
‘broken’ “site:” operator.

These restorations supported the suggestion that
this was merely a temporary technical issue.
However, it wasn’t hard to find other examples of
domains that were still unfindable.

On Sunday, we updated our article to add that
YTMP3.cc and Prostylex were not appearing in
search results; a few hours later these reappeared
as well.

While we were amazed by this magical superpower
that allows us to revive websites by simply
mentioning them, someone else was pulling the
strings. Behind the scenes, DuckDuckGo was
working hard to restore sites that were mentioned in
the media.

It’s Bing

At this point, it became clear that the search engine
wasn’t at all happy with what was happening. They
never actively removed any of these sites. Instead, a
third-party data provider ‘removed’ the results for
them.

Like many other smaller search engines,
DuckDuckGo uses hundreds of data sources,
including Bing. After some back and forths,
DuckDuckGo’s spokesperson informed us that
Microsoft’s search engine was the culprit.

“Yes, this is related to using data from Bing,”
DuckDuckGo’s Senior Communications Manager
Allison Goodman said.

Goodman also asked us to share a list of additional
sites that were affected, so they could look into
these. And indeed, a few hours after we sent over
more affected domains such as 1fichier.com,
2embed.ru, and torrentgalaxy.com, these were
restored as well.

Broader Issue

It’s understandable that DuckDuckGo wasn’t happy
with the coverage. However, the problem was real.
And since it’s emanating from Bing, other smaller
search engines that rely on that data may be
affected as well.

“Since these occurrences originated on Bing, they
were passed down to our results, as well as other
Bing syndication partners,” Goodman clarifies.

For DuckDuckGo, it may be tricky to resolve the
issue permanently as long as it relies on Bing. Aside
from the potential legal implications of actively
restoring pirate sites, there are dozens, if not
hundreds of other domains that are still unfindable.

We don’t intend to keep hammering on this but, at
the time of writing the streaming service gimy.app is
not showing up in the search results.

Inaccurate DMCA Removals?

While looking into these issues, we noticed that Bing
also affects DuckDuckGo in other ways. From what
we can see, the DMCA removals also spill over,
including the inaccurate ones.

For example, some news articles from TorrentFreak
are not available in Bing, presumably due to
takedown requests. That includes this news report
about a leaked Game of Thrones episode.

A few weeks ago Warner Bros. asked Google to
remove this article. Google refused to do so, but it
looks like Bing complied as the article is unfindable

there. When we search for the title or even the URL,
it’s not there.

The same applies to DuckDuckGo, where the article
is not listed. Instead, the top hit is a copy of our
reporting. In Google’s search results our news article
is the first result, as expected.

All in all, we want to emphasize that these issues
are not caused by DuckDuckGo, which has been
trying hard to mitigate the problem. However, the
issues do exist and it is clearly more than a broken
search functionality.
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by Privacy International
Reprinted under GPL v3 license

Firefox provides you with several mechanisms to protect your privacy. However,
some of them are not enabled by default. In this guide you'll learn how to
configure your Firefox browser settings to strengthen your online privacy.

Changing settings in Firefox menu

To change basic privacy settings in Firefox, access the preferences menu by
clicking on Edit > Preferences on the menu-bar, or by entering
about:preferences in the URL bar, and then click on Privacy & Security (Fig. 1)

Fig. 1 : Firefox privacy settings page

Enable content blocking

Content blocking should be enabled by default on your Firefox installation. If not,
find the Enhanced Tracking Protection setting and set it to Standard (Fig. 2). If

you want stronger protection set it to Strict, but keep in mind this can prevent
some pages from displaying correctly.

Fig. 2: Firefox Tracking Protection settings

Enable Do Not Track

When browsing the web, your browser can warn websites that you do not want to
be tracked. Beware that not all websites respect this! For more consistent
protection, please see our guide on installing an ad-blocker. Still, warning

Adjusting Firefox Settings To Enhance Your Online Privacy
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websites that you do not want to be tracked is an added protection. Scroll down
until you see the Send websites a "Do Not Track" signal that you don't want
to be tracked and then click on Always (Fig. 3).

Fig. 3: Firefox Do Not Track setting

Disable telemetry services

To improve its services, Firefox collects technical and interaction data that it later
sends to Mozilla for processing. Part of this also includes the ability to remotely
install extensions on your browser, which can pose a privacy risk. To disable
telemetry services, find the section titled Firefox Data Collection and Use and
make sure to un-tick all boxes (Fig. 4).

Fig. 4: Disable Firefox telemetry

Changing settings in the about:config page

To manage advanced privacy settings, type about:config in the URL bar and
press Enter. You'll then be greeted by a warning stating that some settings may
affect Firefox's performance and security (Fig. 5). Click Accept the Risk and
Continue to enter the settings page.

Warning: This settings page gives access to advanced features that might affect
Firefox ability to function properly. Make sure you understand what you do. All
changes are reversible.

Fig. 5: Firefox advanced settings page

Table 1 shows some of the advanced settings you can change to better protect
your online privacy. Next to each setting is the value we recommend applying, as
well as a brief summary on what that setting concerns. To enable or disable an
option, enter its name in the search bar, and then double click to change the
value. When you do so, the updated value is highlighted in bold and is
automatically saved (Fig. 6).

Fig. 6: Set an advanced Firefox setting

Table 1 : Recommended settings to strengthen your browser privacy

Adjusting Firefox Settings To Enhance Your Online Privacy



PCLinuxOS Magazine Page 39

by Alessandro Ebersol (Agent Smith)

The everyday aspects of technology are so
ingrained in our daily lives, that we don't even think
about whether we can trust this technology. We use
the services and gadgets in automatic mode.

Have you ever stopped to think if the technology you
use can be trusted? That in a Google search, you
trust that the search engine will return the best
results? That Google maps will show you the best
route to a certain destination? The Google example
was a figure of speech, the same questions can be
asked about Microsoft's products, Apple's, Amazon's
services and so on.

If you still trust technology, let me take the veil off the
mass propaganda that sells us that Google is not
evil and that Microsoft loves Linux.

Google manipulates results...

Mike Wacker, a former Google engineer, has
repeatedly claimed that Google engages in manual
manipulation of search results. Not only that, Mike

Wacker called out CEO Sundar Pichai for lying to
Congress about the matter.

This was in addition to then-anonymous claims that
he himself had been advised to reorder search
results. Google has been repeatedly criticized for
manipulating search results, especially by burying
and censoring conservative content while raising
positive results for left-wing content.

In testimony before the House Judiciary Committee
in December 2018, CEO Sundar Pichai was asked
directly by Representative Zoe Lofgren (Democrats-
CA) if "there wasn't a little man sitting behind the
curtain figuring out what we [Google] are going to
show the user."

Sundar Pichai said, "We don't manually intervene in
any particular search result."

Mike Wacker explained in a post on Medium that he
was able to find where Google had actually altered
search results regarding abortion. Google had a
special file regarding blacklisted topics, and if
searches were performed regarding these topics, an
alternative algorithm would trigger alternative search
results.

Another former Google engineer, Zack Voorhies in a
recent interview with The Epoch Times, said that
Google tweaked its algorithm to ensure that the
negative stories in the mainstream media about
former President Trump were what people saw when
they used its search engine, the world's most
popular search engine. Zach Vorhies said that the
tech giant specifically changed its news algorithm to
harm the former president.

"As a Google whistleblower, Vorhies turned over 950
pages of internal Google documents to the Justice
Department's antitrust division detailing Google's
extensive censorship project. This project is called
"Machine Learning Fairness," which has already
corrupted Google Search, YouTube, and News
products. This, along with various blacklists and
secret page rankings, is being used by Google to
manipulate public opinion according to a hidden
agenda."

Waze doesn't know where to go

On October 3, 2015, Francisco and Regina Stringari
Múrmura, 70, had just entered the Caramujo
community when they were met with gunfire. They
were going from Rio to Niteroi and put their

Do You Trust Technology?
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destination address into the GPS navigation app
Waze, an app owned by the Alphabet conglomerate.
Instead of being directed to Avenida Quintino
Bocaiuva, in São Francisco, they were taken to Rua
Quintino Bocaiuva, inside the Caramujo favela. The
drug gang that runs the place didn't hesitate. They
shot at the car and killed the wife, Regina Múrmura,
70 years old. Her husband Francisco, 69, may have
only been saved because the bullets hit silver
candlesticks in the trunk instead of him, according to
an interview with his daughter, Renata, 43.

In a statement, the Waze app says, "We are very
saddened by this incident and offer our condolences
to Ms. Regina Murmura's family. User safety is of the
utmost importance to Waze. Unfortunately, it is
difficult to prevent drivers from navigating to a
dangerous region if that is the destination selected
because people living in these areas need to get
home (...) In Brazil, Waze leaders will meet face-to-
face this week with our partners at the Rio
Operations Center (COR) to understand what the
city is doing in order to address the risks of driving in
Rio de Janeiro" . That's in 2015 in Brazil. But, other
trajectory issues would haunt the app.

In October 2021, Google's second most popular
navigation app ran into problems in Israel, Waze's
home country. The app continued to redirect users to
faraway cities, Haaretz explained, citing a Ynet story
from mid-August. Waze users told the site that the
app "just went crazy," redirecting them out of their
way.

But, enough about Google. We could go on for
months discussing the failings of Google and its
subsidiaries, all run by strange, obscure algorithms
that we know nothing about and only the company's
bosses control.

Microsoft, the "friend" of Open Source

Developer Jamie Kyle wrote (in a removed post, but
still on the wayback machine), "I think it's time to

publicly share how Microsoft stole my code and then
spit on it."

Kyle - whose formidable open source pedigree
includes contributing to Babel, Flow, Yarn, and
serving on the TC39 steering committee - created
Lernajs, a lightweight tool for organizing and
managing JavaScript packages across projects. The
result is that a team at Microsoft apparently mirrored
the Lernajs codebase and renamed it Rushjs. They
didn't fork it, which would be a totally legal open
source thing to do. Instead, it appears - according to
Kyle's very convincing and publicly documented
timeline of events on GitHub - that Microsoft
employees essentially copy/pasted Lernajs.

As an adult, Kyle tried to find out what happened,
approach the other party, and collaborate on a
resolution to the problem. Basically, Kyle just wanted
public recognition of Rushjs' origins. "So I reached
out to the people I knew at Microsoft. This was
probably a year ago. They were shocked and
apologized. But since then, nothing has happened,"
Kyle wrote. "Oh wait, yes, something did happen.
Rushjs history was messed with and a lot of the
code was moved, functions renamed, rewritten....
Instead of just updating a license or even adding a
footnote, they went through all this work, to not give
credit to the real author of the program."

This is just one of the cases where Microsoft has
appropriated other people's code without giving
anything in return, not even credit to the original

author. Let's not forget Keivan Beigi, who created
AppGet, a software that copies the features of the
Linux model of apt-get software installation and
maintenance. At that time, the product manager of
Microsoft's Applications Division expressed interest
in the AppGet project with Keivan, and on the
premise of inviting him to join the Microsoft team,
they had many in-depth exchanges about the design
ideas of the AppGet project, with a 5-moon time
frame. But in the end, Microsoft suddenly lost touch
with Keivan and launched the WinGet project whose
design ideas and code structure were highly similar
to AppGet after half a year.

The abuses of technology companies continue, and
lead us to the sad conflict that is going on between
Russia and Ukraine.

The sad conflict between two sister countries

First of all, I want to make it very clear that I am not
in favor of war, under any circumstances. In the case
of the Russia/Ukraine conflict, it is a situation that
should be resolved between the two countries,
without outside interference in any way. But, this is
not what happened, and neither is it what is
happening now.

Unfortunately, the technology companies are playing
a very ambiguous and mean-spirited role in this
conflict, on the one hand trying to appear to promote

Do You Trust Technology?
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peace, but in fact stirring up hatred. In my view of
what is happening, it is a repeat of the Cuban
missile crisis, only in reverse, in simple lines.

But now we have, in all the technology and
communications companies, censorship and
repression of anything concerning the conflict other
than the official NATO version, that the Russian
president is a mad aggressor.

Facebook allows hate messages against
Russians

In times when users and experts are clamoring for
more efficient content moderation on social
networks, Meta Platforms has made a controversial
decision. Last March, it decided to allow hate
speech against Russian officials and military
personnel on Facebook and Instagram.

YouTube censors Russia Today and Sputnik
channels

Google has decided to censor the Kremlin-linked
channels Russia Today (RT) and Sputnik. The tech
giant will cut the reach of these publications in
Europe during the Ukraine War, with the excuse of
preventing the spread of fake news from the
Kremlin. However, this decision, since most people
nowadays inform themselves through YouTube or
via Google News, creates mass disinformation and
no chance for contradiction, which creates a spirit of
Russian phobia. Yes, the media is instilling hatred
for the Russian people and everything related to
Russia.

Russophobia: a great evil for everyone

Russophobia could not come at a worse time: when
the world is trying to get back on its feet from two
years of pandemic, a conflict, with sanctions on both
sides, which, instead of speeding up the process of

world reconstruction, will only worsen the conditions
and situations that we are all living in, in this "post-
pandemic", quotation marks, since the pandemic
seems to have weakened, but is not over.

All the anti-Russian propaganda, created to justify
the sanctions against Russia, creates a climate of
hatred and xenophobia, something that should be
long over, a page turned.

But this is not what is happening.

We can't forget to mention that Google has sent a
message, to all content creators, valid for Youtube,

blogs and apps monetized by Google Adsense.

In short, the message warns that any content that
spells out that "Ukrainians are responsible for the
tragedy itself or similar examples of victim-blaming,
such as statements claiming that Ukraine is
committing genocide or is intentionally attacking its
own citizens." And, this is not what happens, with
several examples of human shields of the civilian
population, something similar to what happens in
Brazil in the slums, where bandits hide among the
innocent population and use them as shields.

The Evil Effects of Sanctioning Russia

The effects of the sanctions against Russia are
already being felt:

• Oil and gas: Russia is the world's leading exporter
and second largest producer of natural gas. It is
also the second largest exporter and third largest
producer of oil globally, accounting for about 12%
of global supply. Thus, a shakeup in the
production and financing chains in the country
has direct repercussions on the supply of these
commodities worldwide, economists point out.

• Fertilizers: Russia is among the largest producers
of fertilizers in the world, being an important
supplier of Ammonia, Phosphate Rock, and
Potassium Chloride. Brazil is one of its main
clients. The interruption or reduction in the supply

Poster found on the door of a Russian restaurant in NY
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of these items in the global trade chain affects the
costs of food producers and, consequently,
generates inflation.

• Wheat: If we add production and sales in
international markets, Russia and Ukraine
account for almost 30% of world wheat exports.
A reduction or even interruption in the supply of
this part of the commodity has a direct impact on
several food chains.

• In the food industry, for example, it affects the
supply of pasta manufacturers. And, in the raising
of pigs and poultry, the scarcity of this input
increases the costs of breeders, affecting the final
price to the consumer.

Although it affects Europe first, the effects of the
sanctions are already being felt around the world,
with food and fuel prices rising, increasing inflation.

When free speech is controlled by private
companies...

Yes, exactly this. Today we see that free speech, a
relative democratic right, but one that should be
enabled for all, is not possible. The big technology
companies, acting as gatekeepers to everything
related to cyberspace and internet
telecommunications, threaten the free debate of
ideas and create one-sided narratives.

Thus, they create a situation of constant tension, of
a regional conflict that can spiral and involve the
whole world.

American diplomacy, however, also leaves
something to be desired, instigating conflict instead
of seeking peaceful ways out of this situation.

Hope for peace must prevail

When several Western countries began to sanction
Russia, they did not realize that globalization was
not a one-way street, but that everyone depended
on everyone else. So much so that today several
countries are already feeling the effects. The USA
started to import oil from Venezuela, and other
countries like France and Germany may face an
energy crisis, due to their dependence on Russian
oil and gas.

As I mentioned above, US foreign policy has gotten
much worse since former President Trump. Some of
the media presented him as an orange buffoon, but
he would never have let this situation escalate as it
has, and we still don't know how it will end.

Again, do not blindly trust the technology
companies, as they have already proven to be
biased and have their own interests, which do not
contemplate the collectivity. Here, I am praying for
peace. A big hug and see you in the next article.

Screenshot ShowcaseScreenshot Showcase
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by David Pardue (kalwisti)

I enjoy dabbling with languages -- including
constructed languages (conlangs) such as
Esperanto, Interlingua and Ido. My longest as well
as fondest involvement has been with Esperanto,
the most successful conlang to date. I recently
began brushing up on my internacia lingvo
('international language') and realized that I did not
know how to correctly produce its six special
supersigns in Linux. The special supersigns -- also
known as the "hatted letters" (ĉapelitaj literoj) -- are:
ĉ, ĝ, ĥ, ĵ, ŝ and ŭ.

Although the Fundamento de Esperanto
('Foundation of Esperanto') [1905], which lays out
the basis of the language, allows the use of an
alternative method for these supersigns when one
cannot properly type them, it is preferable to use the
correct diacritics whenever technically possible. The
so-called "h-system" allows the workaround of using
ch in place of ĉ, gh for ĝ, hh for ĥ, jh for ĵ, sh for ŝ,
and ŭ is replaced by u.

Since the advent of Unicode, it is much easier to add
Esperanto keyboard layouts in the major Linux
desktop environments. Unicode is a character
encoding standard with the capacity to support over
one million characters. It is being developed with the
goal of having a single character set that supports
all characters from all scripts, that are in common
use around the world today. The era of legacy Latin-
3 encodings and special TrueType fonts has fallen
by the wayside as application support for Unicode
improved. The Latin-3 (ISO-8859-3) encoding
standard, which supported Esperanto, Turkish and
Maltese, was popular from the late 1990s until the
early 2000s. As we will see with KDE and MATE, it is

even possible to type these characters without
installing a separate keyboard layout.

This tutorial explains how to properly type
Esperanto's diacritical letters via Unicode with
minimal fuss in KDE, MATE, Xfce and Openbox --
without needing to change your system locale. (In
my case, the locale remains set as English (US)

[en_US.UTF-8]). I initially made notes just for my
sysadmin journal but later decided to expand them,
in case they might prove helpful to Esperanto
students in the PCLinuxOS community.

KDE

Without Separate Keyboard Layout

KDE Plasma 5.24.x allows you to type Esperanto's
supersigns right out of the box, without having to
install a separate keyboard layout. To configure this,
follow these steps:

Go to the PCLinuxOS (Start) menu >
Configuration > KDE System Settings >
Hardware > Input Devices > Keyboard:

Adding Esperanto Supersigned Letters

Click on the Advanced tab, and locate the option
Adding Esperanto supersigned letters. Under it,
select / tick the option To the corresponding key in
a Qwerty layout:

Key to Choose 3rd Level

Next, scroll down to the section labeled Key to
choose 3rd level. This is where you will choose
your AltGr key (also known as the Alt Graph key or
the Alternate Graphic key) as a "Compose key." It is
located where the Right Alt key is normally found
(to the right of the spacebar). When pressed along
with a keyboard key, it enables the entry of special
characters.

Esperanto Characters On PCLinuxOS
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You will notice a variety of options available; you can
choose whichever key you wish. I selected the Right
Alt key:

I was puzzled by what "3rd level" means until I found
a blog post by Timothy Boronczyk which provides a
clear explanation of the term:

• Each key can be thought of as having multiple
levels. For example, the first level of the C key
would be a lower-case "c". The second level
would be an upper-case "C" (the second level is
accessible [via] the Shift key as a modifier). The
supersigno option maps the accented characters
to the third and fourth levels of the keys of their
respective base glyphs. That is, the third level of
the C key is now "ĉ” and the fourth is "Ĉ".

• Just as a modifier key is needed to access the
second level (Shift), a modifier is also used to
access the higher levels. In my case I set this as
the Right Alt key, a key traditionally used for this
purpose.

One last item to verify is under the section labeled
Miscellaneous compatibility options. Make sure
that the option "Enable extra typographic characters"
is not selected / ticked:

Finally, click the Apply button and you're ready to
type the supersigned letters. This method works
well, providing that you do not mind typing the two-

key combinations listed below. (You must press both
keys simultaneously to produce the supersigns):

Testing with Esperanto Pangrams

People who have taken touch-typing classes are
probably familiar with the sentence "The quick brown
fox jumps over the lazy dog." This kind of sentence
is called a pangram6 because it contains every letter
of the English alphabet. Pangrams have been used
for years to teach typing, as well as to test printers,
typefaces and software. Graphic and font designers
often use pangrams to illustrate their work. Pangram
is derived from the Greek roots 'pan-' (all) and '-
gram' (letter). Two other fun English pangrams are:
"Pack my box with five dozen liquor jugs" and "When
zombies arrive, quickly fax Judge Pat."

Esperanto has a couple of famous pangrams you
can type to demonstrate that your keyboard is
working properly:

Laŭ Ludoviko Zamenhof bongustas freŝa ĉeĥa
manĝaĵo kun spicoj.

('According to Ludwig Zamenhof, fresh Czech food
with spices tastes good')

eĥoŝanĝo ĉiuĵaŭde
('echo change every Thursday')

This is technically not a pangram, but is a popular
nonsense phrase used as a lorem ipsum to test
whether Esperanto's supersigns are working on a
computer keyboard. It contains all six of Esperanto's
diacritical letters.

With Esperanto Keyboard Layout

KDE also offers the option of using a dedicated
Esperanto keyboard layout; this is my preference.

The procedure for installing and configuring this
keyboard is similar to the steps described above, so
I will focus on the steps that differ.

Go to Configuration > KDE System Settings >
Hardware > Input Devices > Keyboard. Click on
the Layouts tab. If the Configure layouts option is
not already selected, tick the box to activate it:

Press the +Add button; an "Add Layout" pop-up
window will appear. In the Search box, type
esperanto to locate the keyboard layout:

Select the (plain) Esperanto layout, then click the
OK button to add the keyboard layout (next page,
top left).

Esperanto Characters On PCLinuxOS
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One handy feature is the Preview button, which
allows you to see a preview of the new layout in a
pop-up window. You can use Spectacle to capture a
screenshot of the layout for future reference, if you
wish.

Next, we need to select a key shortcut for switching
between the two keyboard layouts. Under the
Shortcuts for Switching Layout section, click the
button to the right of Main shortcuts:

This will open up the Advanced tab and take you to
the subsection labeled Switching to another
layout. You will see a lengthy list of available keys
and key combinations you choose from. I opted for
the Win Key+Space combination (at the bottom of
the list):

To complete the installation, click the Apply button
(in the bottom right corner):

At this point, the keyboard layout abbreviation(s)
should appear in your system tray:

If you wish, you can change the display style of the
keyboard layout icons from their text labels to flags.
To accomplish this, right-click on the text label in the
systray, and select Configure Keyboard Layout:

In the pop-up window that appears, choose the
Display style as a flag icon by clicking the radio
button next to it:

Click the Apply button to save this change:

It is simple to type Esperanto's diacritical letters
using this layout:

MATE

Without Separate Keyboard Layout

MATE 1.26 allows you to type Esperanto's
supersigns right out of the box, without having to
install a separate keyboard layout. To configure this,
follow these steps:

Go to the System menu > Control Center >
Hardware > Keyboard:

Click on the Layouts tab to bring it forward, then
click on the Options button:

Esperanto Characters On PCLinuxOS
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Adding Esperanto Supersigned Letters

A Keyboard Layout Options pop-up window will
appear. Find the option Adding Esperanto
supersigned letters. Under it, select the radio
button labeled To the corresponding key in a
Qwerty layout

Key to Choose 3rd Level

Next, scroll down to the section labeled Key to
choose 3rd level. Here you will choose your AltGr
key (also known as the Alt Graph key or the
Alternate Graphic key) as a "Compose key." It is
located where the Right Alt key is normally found
(to the right of the spacebar). When pressed along
with a keyboard key, it enables the entry of special
characters.

You will notice a variety of options available; you can
choose whichever key you wish. I selected the Right
Alt key:

(For a more detailed explanation of what "3rd level"
means, consult the subsubsection "Key to Choose
3rd Level" of the KDE subsection "Without Separate
Keyboard Layout," at the beginning of this tutorial).

One last item to verify is under the section labeled
Miscellaneous compatibility options. Make sure
that the option "Enable extra typographic characters"
is not selected/ticked:

Finally, click the pop-up window's Close button and
you're ready to type the supersigned letters. This
method works well, providing that you do not mind
typing the two-key combinations listed below. (You
must press both keys simultaneously to produce the
supersigns):

With Esperanto Keyboard Layout

MATE also offers the option of using a dedicated
Esperanto keyboard layout; I find this faster and
more convenient.

Begin by going to the System menu > Control

Center > Hardware > Keyboard. Click on the
Layouts tab to bring it forward:

Press the +Add button. A "Choose a Layout" pop-up
window will appear. Click on the By language tab,
and choose Esperanto from the Language drop-
down menu. From the Variants drop-down, select
(plain) Esperanto:

A welcome feature is that MATE displays a preview
of the keyboard layout, and even offers you the
chance to print it. (The Print button is in the lower
left corner of the pop-up window).

Click the +Add button to install the dedicated
Esperanto keyboard and to close the pop-up. The
new keyboard will be listed under Layouts; MATE
also provides an empty box in which you can type to
test it. You are almost finished …

Esperanto Characters On PCLinuxOS
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The final step involves selecting a key shortcut to
switch between the two keyboard layouts. Under the
Layouts tab, highlight the entry for Esperanto.
Next, click on the Options button.

After the pop-up window appears, scroll down to the
Switching to another layout section:

You will see a lengthy list of available keys and key
combinations you choose from. I opted for the Win
Key+Space combination (at the bottom of the list -
see image, center top):

Finally, click the Close button; you're now ready to
type the diacritical letters with the dedicated
keyboard layout. Congratulations!

The keyboard layout text label(s) should appear in
your system tray:

It is easy-peasy to type Esperanto's supersigned
letters using this layout:

Xfce

With English (international AltGr dead keys)
Layout

This method involves installing a second keyboard
layout which uses the AltGr key (whose function is
described in the KDE section above).

Begin by going to the PCLinuxOS (Start) menu >
Settings Manager > Hardware > Keyboard:

Next, click on the Layout tab. Check the status of
the Use system defaults slider (mine was set to
"On" by default). If the slider is in the "On" position,
you will be unable to add another keyboard layout. If
necessary, slide it to the "Off" position (as shown
below):

Click on the Add button. A Keyboard layout
selection pop-up window will appear. Expand the
English (US) menu and select the English
(international AltGr dead keys) layout:

Esperanto Characters On PCLinuxOS
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Click the OK button to install it.

To configure the keyboard layout, you need to select
which key will act as the "Compose key" (AltGr).
Clicking on the drop-down menu, you will see a
whole list of available keys and key combinations
you can choose from. Select the option that works
best for you and your use of the keyboard.

On my old Dell keyboard (wired USB with chiclet-
style keys), I discovered that the most comfortable
"Compose key" was either the Left Win key or the
Right Ctrl key:

Xfce provides another feature to make your typing
life more convenient: a panel plugin. This plugin
allows quick access to switching between installed
keyboard layouts. Although the required plugin is
likely installed on your system by default, it would be
a good idea to check in Synaptic for it: xfce4-xkb-
plugin (0.8.2-1).

To add the plugin to your top panel, right-click on an
empty area and choose Panel > Add New Items:

Next, choose Keyboard Layouts (center, top):

The layout's icon will be placed at the far right end of
the panel. If you wish to move it elsewhere, right-
click on the flag icon and select Move (center):

Another plugin configuration setting that should be
checked is Behavior : Manage layout. To access
this, right-click on the Keyboard Layout icon > then
choose Properties:

For this option, I recommend choosing "globally";
this way, you do not have to remember which
application (word processor, E-mail program, etc.) is
using which keyboard layout.

You are almost ready to use the keyboard layout. To
activate it, just click on the panel icon and select the
"enhanced" keyboard. It should look like this (with a
black dot in the lower right-hand corner of the US
flag):

To type Esperanto's special supersigns, do the
following.

The letters with circumflexes require three separate
keystrokes:

1. Press the "Compose key" (e.g., Left Win) and
release it.

2. Press Shift + 6 (i.e., ^) and release the keys.

3. Press the c key to produce ĉ.

(Pressing g will type ĝ ; h will create ĥ ; j yields ĵ ;
and s produces ŝ).

The u with breve (ŭ) requires some "finger Olympics"
to achieve the successive key presses. Press AltGr
(Right Alt) + Shift + 9. Then, release the keys.
Press the u key to produce ŭ.

If you would like additional information on this
enhanced keyboard layout, as well as where to
download a PDF cheat sheet of other Compose Key
combinations, see Paul Arnote's article on
"Accessing the Extended Character Set."

Esperanto Characters On PCLinuxOS
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With Esperanto Keyboard Layout

Instead of using the multiple-key-combination
approach, I am more comfortable with a dedicated
Esperanto keyboard layout.

The procedure for installing and configuring this
keyboard is almost identical to the steps described
above. The only difference is that when you see the
Keyboard layout selection pop-up window, choose
the Esperanto layout. (Click carefully to avoid
selecting the obsolete [displaced semicolon]
layout):

When you have installed the keyboard layout and
configured the plugin, the icon will look like this in
your panel:

Typing Esperanto's diacritical letters with this layout
is straightforward:

Openbox

I run the PCLinuxOS Openbox community release
on my old 2011 HP Mini netbook. (Thanks, Alie!).
Openbox -- as a lightweight window manager --
does not incorporate a button or widget in the
taskbar which allows you to switch between
keyboard layouts with a single mouse click. So it
involved some work with Sakura (Terminal) to
manually edit system configuration files.

I am a novice with Openbox but online searching
suggested which files likely needed modification. I
poked around in different directories, experimented a
bit and found the relevant file:

/etc/X11/xorg.conf.d/00-keyboard.conf

(As a precaution, I made a Timeshift backup before
editing this file). The contents of my modified file are
pasted below for reference:

Section "InputClass"
Identifier "system-keyboard"
MatchIsKeyboard "on"
Option "XkbLayout" "us,epo"
Option "XkbModel" "pc105"
Option "XkbOptions" "grp:win_space_toggle"
EndSection

The language abbreviation for Esperanto is epo,
and I chose the combination Win Key + Space for
switching between my two keyboard layouts.

Note: This change will only take effect after you
reboot your computer.

Be observant of which layout you are using,
because there is no visual indicator of which
keyboard layout is active. When I finish composing
Esperanto text, I immediately change back to the
English (US) layout so that I do not forget.

If you would like to see the full list of available
options for keyboard models, language maps and
keys for switching between layouts, open this
system file:

/usr/share/X11/xkb/rules/evdev.lst

The file is divided into several sections which are
separated by the headers: ! model [of keyboard], !
layout [language maps], ! variant [keyboard
variants], ! option [switching to another keyboard
layout].

Conclusion

I hope that you have found this tutorial useful, if you
were needing to type more than just an isolated
Esperanto word or phrase. As is typical under Linux,
there are multiple ways to accomplish a given task.
With KDE and MATE, you may choose to type the
supersigns without using a separate keyboard
layout, or via a native Esperanto layout. Within Xfce,
you may use an alternative English keyboard layout
or an Esperanto layout. Select whichever method
works best for you and your use of the keyboard.

If you have family members or friends who are still
stuck with Windows, I will mention two free utility
programs that allow the typing of Esperanto's
diacritical letters without modifying the OS in any
way: EK! and Tajpi.

EK! is an open-source (GPL) program created by
Jurij Finkel, a computer programmer and translator.
Its most recent version (3.9) dates from 2010 and is

Esperanto Characters On PCLinuxOS



PCLinuxOS Magazine Page 50

available at: http://www.esperanto.mv. ru/Ek/ Tajpi
('to type') is also published under the GPL and was
created by Thomas James. The program runs in the
background and uses minimal system resources. It
is a slightly better option than EK!, in my opinion,
because its most recent release (2.98) is from 2016.
Tajpi can be downloaded from:
http://www.zz9pza.net/tajpi/en/

I wish you happy typing ... ĝis la fina venko! This
means 'until the final victory.' This "final success" is
the imagined future moment when Esperanto will be
recognized as the neutral second language for
international communication. Without intending to be
snarky, it is analogous to "The Year of the Linux
Desktop."
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Posted by Meemaw, on April 5, 2022, running Xfce.
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40 minutes to prepare serves 8-10

Ingredients

2-3 cups leftover mashed potatoes
2 cups grated cheddar cheese
1 cup grated Parmesan cheese
1 tablespoon unsalted butter
8 oz elbow or shell noodles
1 cup cooked and crumbled bacon
¼ cup chopped chives or green onion, garnish
*Milk or half-and-half, as needed

Preparation

Preheat the oven to 350°F and bring a pot of salted
water to boil. Cook noodles until just al dente, then
drain and stir in 1 tablespoon of butter to prevent
noodles from sticking together.

Cook bacon, drain on a paper towel and chop into
smaller pieces.

Reheat mashed potatoes in a microwave safe dish.
Transfer to a large bowl for mixing. Note: If potatoes
are dry, add a little milk or half and half for a
smoother texture.

Fold in Parmesan cheese, bacon, and 1 cup
cheddar cheese and stir to combine.

Gently fold in noodles until just incorporated then
pour mixture into a greased 9 x 9 baking dish and
top with remaining cheddar cheese.

Bake for 10-15 minutes or until the cheesy topping is
bubbling and golden brown. Remove from the oven
and garnish with chopped
chives or green onions
sprinkled over the top.

Tip:

Add 1 cup chopped of your
favorite seafood or meat.

For that smokey flavor add 1/2-
1 teaspoon liquid smoke to
mixture

The PCLinuxOS Magazine

Created with Scribus
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
n
lo
ad

P
u
zz
le
S
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ti
o
n
s
H
er
e

Possible score 253, average score 177.

PCLinuxOS Puzzled Partitions
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ACADEMICS ACCOLADE

ALMA MATER ALUMNI

APPLAUSE BACCALAUREATE

BALLOONS CAP AND GOWN

CAREER CELEBRATION

CEREMONY COLLEGIATE

COMMENCEMENT CONGRATULATIONS

CONSCIENTIOUS COUNSELOR

CREDENTIALS CUM LAUDE

DIPLOMA DOCTORAL PROGRAM

EDUCATION FRIENDSHIPS

GIFTS GRADE POINT AVERAGE

GRADUATE INTERDISCIPLINARY

IVY LEAGUE JUNIOR COLLEGE

KEEPSAKE MAGNA CUM LAUDE

MATRICULATE OCCUPATION

PHOTOGRAPHER QUIZZES

SALUTATORIAN UNDERGRADUATE

VALEDICTORIAN
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1. An expression of praise.

2. The ceremony for graduating seniors where they receive

their degrees.

3. With the greatest honor. Used to express the highest

academic distinction.

4. A bachelor’s degree or a farewell ceremony for

graduating seniors from high school or college.

5. The student with the second highest academic rank in a

class who may also deliver a speech at graduation

exercises.

6. Certified documents showing that a person has a right to

exercise official power.

7. A formal act or ritual, often set by custom or tradition,

performed in observation of an event, like a graduation.

8. The student with the highest academic rank in a class

who delivers the valedictory speech at graduation.

9. To enroll as a member of a body and especially of a

college or university.

10. The ceremonial formality surrounding a public event.

Also the name of the march played at many graduations.

11. With high honors. Used to express high academic

distinction.

12. Involving two or more unrelated academic, scientific,

or artistic areas.
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Posted by luikki, on April 1 , 2022, running KDE.

Posted by francesco_bat, on April 13, 2022, running Trinity.

Posted by jogurtmen, on April 2, 2022, running MATE.

Posted by brisvegas, on April 1 , 2022, running Mate.
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